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Revision History 
Revision Date Description 

D 15 Apr 2025 Updated release notes for Ion Torrent™ Genexus™ Software 6.8.4. Added 
the following known issues for Ion Torrent™ Genexus™ Software: 55211, 
55738, and 57508. 

C 09 July 2024 Updated release notes for Ion Torrent™ Genexus™ Software 6.8.2. 
B.0 20 Sep 2023 Minor revision to release notes for Ion Torrent Genexus™ Software 6.8.1.1. 

Removed section on BRCA assay. Removed statement about Genexus™ 
Integrated Sequencer Dx instrument. 

A.0 12 Sep 2023 Release notes for Ion Torrent Genexus™ Software 6.8.1.1. The following 
issues are fixed: 39633, 36388, 40320, 35277, 42846, and 36955, and 
Known Issues 42847, 42946, 43231, 43896 and 42946. Known Issue 1796 
was added for Genexus™ Integrated Sequencer Control Software 6.8.1.1. 

Release Notes Overview 
This document outlines major features in Ion Torrent™ Genexus™ Software 6.8, 6.8.2, and 6.8.4 and issues 
fixed in Genexus™ Software 6.8.0, 6.8.1.1, and 6.8.2. Known issues, most of which are to be fixed in 
subsequent releases, are included and apply to Ion Torrent™ Genexus™ Software 6.8, 6.8.2 and 6.8.4. 
Information about the mitigation and impact is included, if applicable.  

Languages supported in Genexus™ Software 6.8 
Genexus™ Software 6.8 supports the following languages. 

• English • Italian 
• French • Japanese 
• German • Spanish 

  

 

Languages supported by the help system and documentation 
The Genexus™ Software 6.8 help system, user guide and release notes are available only in English. 

Antivirus software 
We have tested Genexus™ Software 6.8 with the following antivirus software products and found that 
the products are compatible as antivirus solutions. 

• Bitdefender GravityZone™ Business Security 7.0.3.2115 https://www.bitdefender.com/business/ 
• AVAST Premium Business Security 4.2.0 https://www.avast.com/ 

 
Note: Antivirus software definition files are updated frequently, sometimes daily. Definition file updates 
for antivirus software can bring additional settings or updates to the system which may affect the function 
of Genexus™ Software. 

https://www.bitdefender.com/business/
https://www.avast.com/
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Genexus™ Software 6.8.4 Key Feature 
 
Ion Torrent Genexus™ Integrated Sequencer Deep Clean procedure 
A Deep Clean procedure can be run periodically to improve the performance of sequencing runs on the 
Genexus Integrated Sequencer and minimize unplanned downtime. The Deep Clean option can be started in 
the Settings menu on the sequencer. 

 

Genexus™ Software 6.8.2 Key Features  
 
Ion Torrent Genexus™ Integrated Sequencer security 
The system configuration is enhanced for security on the Ion Torrent Genexus™ Integrated Sequencer. 
 
Updated date format in PDF reports 
PDF reports are updated to use the date format DD MMM YYYY; for example, 21 OCT 2023. This change 
allows the PDF reports to be consistent with the date format used in various geographical regions. 
 
Improved output results for the Customer Support Analysis (CSA) plugin   
The Customer Support Analysis (CSA) plugin was improved to show output that includes all expected file 
folders and the entire expected list of HTML, JSON and log files. 
 
WORM (Write Once Read Many) policies supported for backups and restorations 
Backups and restorations of data and run archives to Network Attached Storage (NAS) devices and 
Amazon™ Web Services (AWS) directories are now supported when Write Once Read Many (WORM) 
policies are enabled. During the restoration of data or archives, the following will occur. 

• Genexus™ Software will always restore the latest copy of the data. 
• The software will add version numbers to the archived data on the storage device. 
• The versions will be displayed in parenthesis in the run name column on the Restore Run screen. 
• The software will always create a copy of the backup and try deleting the older copy.  
• In systems in which the WORM policy is not enabled, the software will overwrite the older version. If 

WORM is enabled, the software will not overwrite the older version and will make a new additional 
updated version of the backup.  
 

Ion Reporter Uploader compatibility 
If you want to upload sample results from a Genexus™ Integrated Sequencer to an Ion Reporter™ Server  
to further analyze the results, you must configure a connection in Genexus™ Software to Ion Reporter™  
Server 5.16 or later. 

Improved process to check for leaks when Genexus™ Integrated run starts 
The Checking for Leaks step that occurs when the Genexus™ Integrated Sequencer run is initiated is 
extended in Genexus™ Software 6.8.2 to check for more possible consumable issues. Additional clog, leak 
and flow tests on the chip coupler and bottles are necessary to confirm that all reagents are leak-free and 
flow properly to help prevent consumable related run failures.  
 
The entire Checking for Leaks step will now take 22 minutes, if there are no failures, for runs that use a new 
chip. Runs that use an existing chip that is on the instrument deck will continue to run the current 3.5 minute 
Checking for Leaks step. If consumable error warnings are shown on the instrument screen, operators 
should follow the prompts to replace the consumable as indicated on the screen and continue with the run. 
After replacement, the instrument will re-run the Checking for Leaks step. 
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Genexus™ Software 6.8 Key Features 

Ion Torrent Genexus™ Integrated Sequencer security 
The system configuration is enhanced for security on the Ion Torrent Genexus™ Integrated Sequencer. 
Genexus™ Software includes all updates contained in the Genexus™ Security Package v1.0.0. 

Assay Application Support 
Genexus™ Software now expands support of assays and applications. Default analysis parameters are now 
optimized to better support implementation of human custom assays. 

Oncomine™ Precision Assay has the following new features and enhancements 
• Novel variant calling is enabled for the entire panel for FFPE samples. 
• Re-sequencing for cfTNA is enabled, which increases the maximum number of samples to 6 

samples with controls in a single sequencing run on a GX5 chip. 
• CNV calling module is integrated for both cfTNA and FFPE, and parameters are adjusted to increase 

the specificity in the FFPE pipeline. 

Increased sample capacity 
Compatible with up to 48 barcode reactions for increased sample capacity per run.  

Support for 2-pool designs for Ion AmpliSeq™ HD custom panels 
Genexus™ Software 6.8 supports 2-pool designs for Ion AmpliSeq™ HD custom panels, allowing 
sequencing runs that target full genes on the Genexus™ Integrated Sequencer with these panels. 

Ability to update annotation sources 
An administrator-level user can get the latest additions, deletions, or changes to the ClinVar database in 
Genexus™ Software. 

Rules for variant names 
Genexus™ Software provides standard conventions for the names of genomic variants. Standard variant 
names are derived from sample and results data and properties that are available in the software for each 
variant, such as variant, gene name, and amino acid change. The conventions are used for both de novo 
variants and variants that are included in a hotspots file. 

Download variant results in TSV format 
When you view variant results in Genexus™ Software, you can now download the information for the 
variants and the annotations associated with the variants in TSV format. 

New sample attribute: Nucleic Acid Type 
Nucleic Acid Type is now available as a sample attribute. 

Download sample results for a selected assay 
You can now download sample result files of your choice from an assay that you select in Genexus™ 
Software. Select the assay in the software, and the samples of interest to download a compressed folder in 
ZIP format. 

Electronic signature enhancements 
Notification and confirmation messages appear when edits are made to an electronic signature. Signed 
reports will show first and last name of the signature user. 
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Data and annotation source updates  
The following annotation sources are updated. 

• ClinVar • RefSeq Gene Model 
• COSMIC • Ensemble Gene Model 
• dbSNP • OMIM 
• DrugBank • Pfam 
• GO • PhyloP Scores 

New user-access level for users to view and electronically sign off reports 
Administrator-level users can now create users whose primary role is to view and sign off on reports. Users 
who are assigned the Report role can do the following actions in the software. 

• Access the Sample Results and Run Results screens to view results 
• Generate, view, and sign variant reports 
• Send notifications 
• Download results files 
• View and edit notes for the sample result 
• View the audit trail for sample results 
• View notifications 

New summary report design 
PDF reports generated in Genexus™ Software have a new design layout. 

View and download Final Reads QC metric 
The number of library reads that pass all filters for sample results, and sample results from runs that are 
resequenced, are now included as a QC metric in the software. You can view Final Reads and Final Reads 
— Resequencing in the QC tab of the Results screen, download and generate the metric in summaries of 
run results, and find the metric recorded in output BAM file outputs. 

Issues fixed in Genexus™ Software 6.8.2 
48760 When reanalyzed run results were deleted, the sequencing output file for the original run was also 

deleted.  
49178 The data collect service stopped after a restart for a backup mount when the mounted drive was 

inaccessible or slow to respond. 
48708 Control samples (an NTC and a positive sample) were not included in a reanalysis when a reanalyzed 

run was initiated from the sample level with a Library to Results assay. 
46471  
 

PDF reports were not automatically generated for reanalyzed runs, although the original run plan was 
configured to automatically generate a report.   

45614  Under certain circumstances, run data might not be included in a backup if the run was initiated and 
completed, or updated, within a long-running backup job.  

45067 Analysis results could not be imported from a backup location that had backup mount points that 
pointed to the same source and target server locations but used different directory names for both 
locations. The issue caused the analysis results import to fail even though the software showed it was 
successful, and also led to repetitive logs in the DataArchival log that were misleading. 

34115 If you reanalyzed a sequencing run that had been imported to another Genexus™ Integrated 
Sequencer, information about reagents was missing from the Reagents section of the Run Summary 
screen. 

45359 When run results for PQ runs were reviewed in from the Dashboard, links named Download Files, 
Report and Reanalysis might have produced an error or show incorrect results. The errors did not 
affect the original PQ run or the state of the Genexus™ Integrated Sequencer.  

45469 The Amino Acid Change and Nucleotide Change columns were empty when a TSV file was 
exported from the Variants tab in the Sample Results screen. The variants data is now shown in the 
columns of the exported TSV file. 
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36669 
 

Unexpected sample results occurred when one variant that had more than one allele included multiple 
alleles annotated as a UCSC Common SNPs annotation, and a filter chain that included the UCSC 
Common SNPs filter – including the TMB score filter chain and the Oncomine™ Extended filter chain – 
was applied to the results.  

46123 When the Use Latest Annotations option was enabled, the ClinVar annotation source versions of the 
annotation set for the assay and the version of the ClinVar filter in the filter chain used were incorrectly 
compared, which in some cases resulted in incorrect warning messages. The software now correctly 
compares the ClinVar annotation source version that is used by the assay and the version of the 
ClinVar filter in the filter chain, so that incorrect warning messages are no longer shown. 

48322 If you exported a variant summary file in TSV format from the All variant class view for sample results, 
the Variant Name and Gene Name columns were duplicated in the TSV file, and the data was missing 
from the Variant Name column. The data in the Gene column was overwritten by information from the 
Annotations tab below the variant table.  
The following fixes were made to correct these issues: 

• The option to export a TSV file from the All variant class view was removed. The option to 
export a TSV file from the individual class views of variants from the other variant classes, and 
the option to export a Microsoft™ XLS format file are still available.  

• The option to download an All variants TSV file from the Download File menu was removed. 
The option to download a VCF file that contains All variants is still available. 

48522 Genexus™ Software now supports backup and restoration of data to a storage with ext4 format. 
47970 JNLP files used by the Broad Institute Integrative Genomics Viewer (IGV) will now expire after 24 hours 

after downloading the file. 
46639 
 

Sample results comparisons did not refresh to show the correct variants in the Sample Comparison 
screen when system-installed or user-defined filter chains were applied to sample result comparisons. 

38073 When some gene lists were designated as default in Genexus™ Software, more than one gene list 
became the default gene list. This occurred during a software upgrade. 

45430 If an invalid SMTP account is configured in Genexus™ Software, emails are not sent, and the email 
module does not time out. 

47147 Concentration values were not rounded off. As a result, a comparison in the software of concentration 
value to the threshold value might be incorrect. 

45907 The denaturing temperature was required to be changed from 99C to 98 C in custom AmpliSeq™ 
templates. 

48377 The coverage graph was not shown in visualizations of sample results that used the Oncomine™ 
BRCA Assay GX v3.7.0 or Oncomine™ BRCA Assay GX v3.6.0 when the default filter chain was 
applied.  

35450 Reports that were signed off for runs that were performed and backed up on Genexus™ Assay 
Development Software version 6.6 could not be exported from, or imported to, another Genexus™ 
Integrated Sequencer. 

20738 Downloads failed for Customer Support Archive (CSA) files if another CSA was downloading at the 
same time. 

Issues fixed in Genexus™ Software 6.8.1.1 
Issue number  

42846 An issue was discovered which prevented restore functionality in Genexus™ Software 6.8.0 for 
instruments that have a hyphen (-) in the server name. This includes the default factory-shipped 
instrument names, which contain a hyphen (-) in the server name. No data was lost, and data remained 
in the stored location(s). Data could still be backed up or archived but could not be restored from the 
backup or archived location. 

39633 A warning symbol   with a message that stated “Sample concentration out of range” was shown in 
error for automated sample dilution in the Run Plan screen when you planned a run, or viewed the Run 
Summary screen, in Genexus™ Software. 
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Issue number  
36388 The expiration date for verification runs that were performed during installation of Genexus™ 

Integrated Sequencer or for performance qualification (PQ) did not match the expiration date shown on 
the Genexus™ GX5 or Genexus™ GX7 chip product labels. The incorrect date was shown in the 
Reagents section of the Verification Results screen, and in the Verification PDF report for verification 
runs. 

40320 Oracle™ Java™ documentation states that the Java™ security feature has been updated, which 
caused issues with the JNLP not loading in updated versions of Java™, due to JARs that are signed 
with weak algorithms. This applied to Java version 8 Update 351 and later, and affected the JNLP file 
that is required for use of the Broad Institute Integrative Genomics Viewer (IGV). 

35277 Some of the context-sensitive help that was shown in the Assay Metrics tab of run results was not 
displayed correctly. When you hovered over either the blue or gray sections of the bar graph for 
"Loading" wells the help pop-up showed a count for a number of "Wells with ISPs". The gray sections 
of the graph now show information for the number "Empty Wells." 

36955 
 

The following issue was listed incorrectly in Rev. A of these release notes as a Known Issue, however, 
it was not an issue for Genexus™ Assay Development Software: Some QC values of "N/A" were 
shown intermittently in the Run Results screen. 

Issues fixed in Genexus™ Software 6.8.0 
30178 If you clicked Run Plugin for a sample result while data backup is in progress, the 1.wells files, the 

basecaller output, and the coverageAnalysis plugin source files for the sample result are deleted. If this 
issue occurred, the Loading Density image and histograms were not shown in the Assay Metrics and 
Run Report screens and values are absent for some QC metrics.  
Note: The affected run report data are available in the Run Report PDF. 

28945 Sequencing run results that were imported to another Genexus™ Integrated Sequencer, showed a 
signed report that was locked for electronic signatures as a draft report on the system with the imported 
results.  

29228 If there were three report templates marked as Default for an assay or application category, you were 
unable to edit the report template. 

29089 Users assigned to accounts with the Manager Role were unable to access Audit records for the 
Services screen and Sample Attribute mapping. 

28490 Custom baselines (CNV baselines, sequence variant baselines, exon tile assay baseline) that were 
created on one Genexus™ Integrated Sequencer could not be imported to another Genexus™ Integrated 
Sequencer in ZIP format. 

25307 The manual signature title of a report did not show correctly when the default report template was used. 
20701 Downloads of sequencing results from the Oncomine™ TCR Beta‑LR Assay GX assay that included 

unmapped BAM and FASTQ files had no dialog box to indicate that the download started and was 
successful. 

25474 The Uracil DNA Glycosylase (UDG) Treat DNA setting is used to clean up deaminated Cytosine bases 
from degraded samples. If you enabled the UDG Treat DNA parameter in an assay, you might have 
observed read imbalances in the Barcodes with Reads Reported table. Read imbalances can occur 
because the on-instrument dilution of input sample nucleic acid is impacted by this setting. 

29239 If manual and automated backups occurred at the same time, the intermediate files might have been 
deleted without a successful backup. 

29905 If you enabled Generate Report when you planned a run, you could not download lab reports when 
you clicked (More Options)Download Files and selected the Reports checkbox in the Download 
Files dialog box. 

30233 If you enabled Generate Report when you planned a run, the report that was generated was always in 
English regardless of the language that is associated with the report template. 

30234 If you enabled Generate Report when you planned a run, the language was not shown in the pane for 
the report in the Reports tab. 

28908 For some results, the ClinVar track was not shown in the Integrative Genomics Viewer (IGV) view that 
is generated with the JNLP files that are downloaded from Genexus™ Software.  
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21585 
 

When you edited multiple samples at once and changed the cellularity or necrosis value for one 
sample, the new value was applied to all samples in the Edit Sample screen. 
 

21293 
 

If you created a custom sample attribute with an attribute name that contained a full stop or period (.), 
the entries for that sample attribute were not shown in the Manage Samples table. 

33765 The Run Summary tab in the Sample Results screen 6.6 sorted 2-library positions that contained 
multiple barcodes alphabetically, instead of showing the actual order of pools as used in the run.  

13478 When you clicked any of the links for the Exome Aggregation Consortium (ExAC) browser in the 
Annotations tab shown below the Variants table, a message redirected you to the gnomAD browser 
was shown. 

20720 
 

If you added all available columns to the list of samples in the Samples / Manage Samples screen and 
then tried to filter the list of samples with the Tags column, an error message was shown.  

21985 
 

If you performed a run with a sample, then performed a second run with the same sample, you were 
unable to edit the sample information after the second run. 

20742 
 

If you enabled the option to upload immune repertoire BAM files to another Genexus™ Integrated 
Sequencer when you planned a run, the option to perform an analysis in the target software 
automatically after run completion was not available.  

23545 NTC QC results for Sample to Result runs were visible only for samples that were included in the 
purification batch with the NTC. 

21485 
 

If you tried to compare immune repertoire results from BAM samples that had been uploaded from 
another Genexus™ Integrated Sequencer, no comparison results were shown. 

22549 In the Key Findings tab, in the Coverage Graph for genes that are transcribed from the reverse strand, 
the order of the exons was shown incorrectly when you placed the pointer over the transcript track. In 
previous releases of Genexus™ Assay Development Software, the orientation of transcripts that are 
transcribed from the reverse strand could only be viewed in the Broad Institute Integrative Genomics 
Viewer (IGV) or with other genome browsers, such as the UCSC Human Genome Browser. 

22883 If you selected a gene that was not shown by default in the Coverage Graphs, in some cases the 
coverage graph was not shown for the gene that you selected.  

21778 
 

For some assays, when you viewed all of the variants in the Variants table, you could add the P-Value 
column to the table twice. 

23399 The option to create a custom filter chain to filter variant results by allele frequency did not appear to be 
available when you selected Assays►Manage Presets, then selected the Filter Chains tab and clicked 
Add New►Choose Filter. 

21930 If you created a custom filter chain for a variant classification, then tried to apply the custom filter chain 
to a result, a “Data not available” message appeared. 

21794 
 

In the Gene Browser, in some instances, the target region was represented with a black color instead 
of green. 

23057 When you viewed the exon tile fusion imbalance charts for a sample, then selected a different sample, 
the charts were not updated for the new sample that is selected.  

23586 For the Oncomine™ Myeloid v2 - GX5 - DNA and Fusions - w4.2.2 assay, Purification QC was not 
included by default. 
 

22005 
 

When you tried to download a BAM result file larger than 2 GB, the file that was downloaded was 0 KB 
and did not contain any data. 
 

21486 
 

If you uploaded a DNA & RNA sample result from one Genexus™ Integrated Sequencer to another 
sequencer and the name of the sample was more than 50 characters long, two samples were created 
on the target sequencer. One sample was for DNA (with a sample type of DNA & RNA), and another 
was for RNA (with a sample type of RNA). 

21357 In the Manage Assays screen, when you selected DNA and Fusions, DNA, Fusions to refine the assay 
list with the filter tool in the Research Application header, no records were shown even if records were 
available. 

21712 
 

If you sorted the list of copy number baselines, sequence variant baselines, or exon tile assay 
baselines by name, an error message appeared that indicated the action could not be completed. 

https://genome.ucsc.edu/
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1316 
 

If the error message “Lane clog check failed” was shown after a clean instrument procedure, the 
message appeared only briefly. 
 
 

31901 Spearman's correlation coefficient was calculated incorrectly using all clones when performing a 
pairwise sample comparison in the Oncomine™ TCR Beta-LR GX assay.  

 

Known issues in Genexus™ Purification Instrument Control 
Software 6.8.1.1 

Issue 
number  Issue Summary Impact and Mitigation1 

1340 
 

In rare cases, a purification run can fail when the gantry 
on the Genexus™ Purification Instrument can stall when it 
moves to the home position and drop a tip in column 1 of 
the tip racks. 

There is no lasting impact to the 
instrument and service is not required. 
This issue occurs immediately before or 
after quantitation. As a result, sample 
extraction is completed, so samples should 
not be affected. 
Workaround: Check the archive plate for 
extracted samples, then perform a manual 
quantification of those samples. If the run 
used was a Sample to Report run, plan a 
Nucleic Acid to Report run and then 
manually add in the concentrations of the 
samples after the manual quantification. 

933 
 

When you sign in on the Genexus™ Purification 
Instrument the error message “Error in response from TS” 
might be shown on the instrument screen, or the 
countdown timer runs continuously.  

To resolve the issue, close the error 
message then try to sign in again.  
If the countdown timer runs continuously, 
you must reboot the instrument, then wait 
one to two minutes, and try to sign in 
again. 

1796 The About This Instrument screen shows Software 
Version: 6.8.1 on the Genexus™ Integrated Sequencer 
screen. 

Workaround: Sign into Genexus™ 
Software on a computer to see the full 4-
digit software version number. 

794 If a USB update for the purification instrument failed, 
there is no notification in the software. 

When you attempt to update the 
purification instrument software from a 
USB, the message “Install Completed; 
Please Reboot Now” appears regardless 
of whether the software update is 
successful.  
Tap Instrument Settings►About to view 
the software version and confirm that the 
software update is complete.  
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Known issues in Genexus™ Integrated Sequencer Control 
Software 6.8.1.1 

Issue 
number  Issue Summary Impact and Mitigation1 

933 
 

When you sign in on the Genexus™ Integrated 
Sequencer the error message "Error in response from 
TS" might be shown on the instrument screen, or the 
countdown timer runs continuously. 

To resolve the issue, close the error 
message then try to sign in again.  
If the countdown timer runs continuously, 
you must reboot the instrument, then wait 
one to two minutes, and try to sign in 
again. 

Known issues in Genexus™ Software 6.8.4 
Issue 
number  Issue Summary Impact and Mitigation 

55211  When files are downloaded more than once from the 
Sample Results screen, the VCF file is not included in 
the ZIP file. 

Mitigation: Refresh the Sample Results 
screen before you download the ZIP 
results file for each sample. 

55738  The error "Cannot read properties of undefined (reading 
'dispose')" is shown in the Gene Browser if the sample 
name in the dropdown list at the top of the Sample 
Results screen is changed.  

Mitigation: Click Results at the top of 
the screen to reload the Sample 
Results screen. Then select a sample 
to review the Gene Browser section in 
the sample results. 

57508 When audit results of Planned Runs are downloaded 
from Results>Run Results>Audit screen, the PDF file 
named <PlannedRun-AuditTrail.pdf> contains incorrect 
information about assay and run plan names. 

Mitigation: View audit details in the 
software  screen, or download results 
files from the Sample Results screen 
and review the audit details PDF in the 
sample results ZIP file. 

51913 Genexus™ Software will automatically delete the 
following log files 12 months after files are created, even 
if the Enable Auto Deletion option in the Manage Logs 
settings has been deselected (that is, disabled): 
genexus.log, ApplicationLog.log, execution−time.log, 
InstrumentGx5.log,  
InstrumentPurif.log, DataArchival.log. 

After 12 months, the deleted log files 
will not be available for use with 
troubleshooting. All audit records are 
retained however and are not impacted 
by this issue.  
Mitigation: The log files must be 
manually backed up to a desired 
backup location if retention of log files 
longer than a year is required. Contact 
your FSE for additional assistance. 

49638 During backups in Genexus™ Software 6.8.0 or later, in 
which both raw and intermediate file types are selected 
for backup, the temp.tar.xz file that was created for the 
previous backup remains in the backup location, and an 
empty temp.tar file is created for the new backup. If both 
raw data and intermediate files were backed up in an 
earlier version of Genexus™ Software, the following 
issues can occur: 
• If intermediate file types are selected for backup and 
backup criteria is met, a backup is initiated, even if run 
has already been deleted. 
• During restore, if the empty temp.tar file is untarred, no 
intermediate files are restored and the software will not 
display images such as histograms and plots for the 
restored files. 

The correct intermediate files should be 
restored. Contact a Field Service 
Engineer (FSE) for assistance with a 
manual untar of the correct tar file that 
has been copied back to system but 
was not untarred. 



 

Genexus™ Software 6.8 Release Notes 11 

Issue 
number  Issue Summary Impact and Mitigation 

51915 Sample results show an In Progress spinner icon in the 
QC status column for sequencing runs that include 
samples that are created with the Application 
Category "Other” and the Download Files option is not 
available in the sample results screen. 

There is no impact on the QC 
evaluation and values for individual 
samples. However, files cannot be 
downloaded in the software from the 
Download Files option. Contact your 
Field Service Engineer (FSE) for 
assistance with downloading files if this 
issue occurs. 

48462 If English is not set as the primary language in the Web 
browser, column headers in the Microsoft™ Excel 
spreadsheet that is downloaded are translated into the 
language selected in Genexus™ Software, and there 
are no drop-down menus for the sample attribute 
columns Cancer Stage, Sample Type, Cancer Type, 
and Nucleic Acid Type. When you use the file to import 
samples into the software, an error message shows a 
failure to upload the sample data. 

In the Web browser, set English as the 
primary language before you download 
a template file for sample creation. 

24019 

Human Genome Variation Society (HGVS) sequence 
variant nomenclature guidelines require cDNA level 
duplication to be annotated as dup (that is, c.1934dup) 
instead of ins (that is, c.1934_1935insG). In  
Genexus™ Software, cDNA duplications (dup) 
annotation implementation is incomplete. Single-base 
duplications are annotated as insertions (ins), not dup; 
multi-base dups are mostly annotated as dup with the 
exception of a non-left aligned minus strand dup may 
still be annotated as an ins.  
 
Protein (amino acid) duplications have however, 
functioned correctly since Genexus™ Software 6.2. 

The dup/ins difference in annotation has 
no functional difference. To find a 
variant named as cDNA dup, you may 
need to look for insertions (ins) with 
similar positions as the dup, and check 
the results in Integrative Genomics 
Viewer (IGV) for nearby sequences to 
match the dup with the ins variant. It is 
also recommended that you rely on 
protein annotation to identify variants, if 
available. 
A complete fix is planned to support 
single-base cDNA duplications, as well 
as all cases of multi-base 
duplications, in a future release. 

49548 In rare cases, PDF reports are not generated and 
cannot be viewed. When Download or View Report is 
clicked, the file that is downloaded is 0 bytes.  

Restart the Genexus™ Integrated 
Sequencer, then regenerate the report 
or reports. The reports can then be 
downloaded and viewed. 

48992 A report for a run is that is imported to another 
Genexus™ Integrated Sequencer and is based on a 
user-defined report template, is not shown if the report 
template is not available on target machine. Additional 
reports that exist for the same run might also not be 
shown if the reports are imported after the run is 
imported. 

Create the report template that is used 
in run on the target machine before the 
run is imported to ensure that the report 
is shown. 

49030 When only the Final Result file is backed up for a run on 
one Genexus™ Integrated Sequencer and then restored 
on the same machine or imported to another Genexus™ 
Integrated Sequencer, complications can occur with 
subsequent backups of additional data. Specifically, 
issues arise when attempting to back up the 
Sequencing Output and Intermediate Files if these files 
are missing after being restored or imported. The 
backup is marked as failed and generates a notification. 

If you regularly back up Sequencing 
Output and Intermediate files, ensure 
that those files are available for all 
samples that have been imported. If you 
are not sure whether all samples 
include Sequencing Output and 
Intermediate files, manually backup 
samples separately that do not include 
Sequencing Output and Intermediate 
Files. 
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49496 
 

If you try to back up a sequencing run that was imported 
or restored, and the sequencing output files are not 
available, and the backup settings on the target 
sequencer to which the run is imported or restored, if 
the backup settings are set to include sequencing 
output files, the backups for the sequencing output files 
will fail. 

Review the error logs and verify that 
they include the message "Signal 
processing files do not exist for ExpId: 
#". Runs with sequencing output file will 
have been successfully backed up. We 
recommend that you then disable the 
backup setting for backups of the runs 
that failed to include the sequencing 
output files. After you disable the 
setting, perform the backup process 
again for the runs that did not include 
sequencing output files. The sequencer 
will not attempt to back up the missing 
sequencing output files, so that the 
backup of those runs is successful. 

48957 When a run is archived and the Genexus™ Integrated 
Sequencer subsequently deletes all data, you can open 
an archived run, then generate and sign off a report. 
The signed off report is the only file that exists in the 
report folder. 

A report that is generated for an 
archived run will not be added to a 
backup. Therefore, do not generate 
reports from runs that have been 
archived. 

48676  
 

ASXL1 is a tumor suppressor gene with 13 exons, one 
of which (exon 3) is 3 nucleotides long. The functional 
annotator within the software uses an ASXL1 transcript 
model based on BLAT alignments, which does not 
properly localize or separate out this small exon. As a 
result, small variants in ASXL1 exons 4 through 13 will 
be annotated with an exon number that is 1 lower than 
expected.  

There may be exon numbering 
discrepancies between the functional 
annotation results in Genexus™ 
Software and from other tools (including 
the Broad Institute’s Integrative 
Genomics Viewer (IGV), and other 
functional annotators) or literature 
reports. 

48965 
 

During a system report check, you may encounter a 
warning regarding incorrect permissions for the 
"webapps" directory. This issue has been addressed 
through security fixes, and the permissions for the folder 
are now correct. However, the expected permission that 
is used for the check has not been updated, which 
results in a warning. 

You can ignore the warning if the 
expected permissions for the “webapps” 
directory are drwxrwsr--. 

43941 
 

When the smoothing parameter is set in results from 
the ReproSeq™ PGS - GX5 - w1.0.2 and ReproSeq™ 
PGS - No Gender - GX5 - w1.0.2 assays, the default 
value that is applied to smoothing is 1, which gives 
equivalent results to a value of 7. 

To increase smoothing in the results 
that use the affected assays, you can 
change the value for plots, in a sample 
result or a sample comparison, from 8-
100. To decrease smoothing, you can 
change the value from 2-6. Setting a 
value of 1 gives the same result as 
7. Setting a value of 0 removes 
smoothing completely. 

37305  Notifications are shown in the Dashboard to indicate 
that a backup of system data and final results failed, 
although no backup directory is configured. 

These messages can be disregarded if 
there is no backup directory is 
configured. 

47524 If you use the NOT option and select the Include 
unannotated checkbox when you create a filter chain, 
variants listed in the results to which the filter chain is 
applied might not be correct. 

Do not select the Include unannotated 
checkbox when you use the NOT 
option. 
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47617 An issue that originates in the TMAP module during the 
one_gap implementation in end_repair, which is initiated 
by using the "-M 4" parameter, can trigger an error when 
a 50 bp read is an exact duplicate of 25 bp and the 
reference contains only one copy of the 25bp. When the 
software attempts to improve an amplicon-based repair 
on the original alignment of 25S25M, an alignment of 
25M25I, which is not allowed, is found, which results in 
an out-of-range value. 

This issue was found in copied and 
edited Oncomine™ Comprehensive v3 - 
GX5 w5.0.2 assays, with the default “-M 
3” parameter changed to “-M 4”. The 
root cause suggests that the issue 
could happen with any Oncomine™ 
DNA or Oncomine™ DNA and Fusions 
assays, released with Genexus™ 
Software 6.6, and customized by a 
user. To continue to use these assays, 
you can disable Use BED File option 
from Read Mapping parameters of the 
customized assay. Subsequently, the 
assay should function without any 
issues.  

47782 If you create or edit a report template and remove an 
image that is attached to the Image Section, you will 
not see the image removed from the section in the 
software screen.  

The report that is generated from the 
template correct excludes the image 
that is removed from that section.  
 
Instead of trying to remove the image 
from the Image Section and leaving the 
section inserted in the template, 
complete the following steps. 

1. Remove the entire Image 
Section from the template. 

2. If you still need an image in the 
report, add a new Image 
Section and then attach the 
desired image. 

3. Save the template. 

48281 The following statement in the Genexus™ Software 6.8 
system help, and user guide is incorrect: 
The sample name can contain only alphanumeric 
characters (0–9, Aa–Zz), periods (.), underscores (_), or 
hyphens , cannot contain spaces, and is limited to a 
maximum of 20 characters. 

Sample names can contain a maximum 
of 50 characters. 

47138 
 

The run status is shown as Planned incorrectly after the 
software is restarted.  

This issue affects only the status that is 
shown in the software. No data loss 
occurs. 
The correct status is shown in the 
software when the run plan is selected, 
or the run is started on the instrument. 

47211 
 

When a Sample to Result run plan is created or copied 
and edited, and a non-numeric value is entered during 
the Purification step, an error is shown that indicates 
the run planning cannot continue. 
 

If you receive this error, enter a valid 
numeric value to continue with the 
Purification step, then complete the 
run plan creation or edit. 
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17186 Genexus™ Software 6.6 allowed the creation of 
annotation sets using a Gene Model, Canonical 
Transcript, and Functional Score with different versions 
of annotation sources. However, if such an annotation 
set is used in the sequencing run, the gene coverage 
plots and drop-down menus in the Key Findings tab will 
be empty. 

To view coverage data that includes 
exon information that is available on the 
gene coverage plots, replace the 
annotation set that uses a Gene Model, 
and Canonical Transcripts from the 
same annotation source version, then 
add the annotation set to the assay and 
reanalyze the sample. 
To view coverage data that does not 
include exon information, you can view 
results from the CoverageAnalysis 
plugin. 

46847  
 

When the Zygosity filter is used in a filter chain with the 
following settings, no variants are shown in the results 
to which the filter chain is applied. 

1) Contains is selected from the Select Specific 
Annotations drop-down menu. 

2) And one or more of the 
Homozygous or Heterozygous checkboxes 
are selected.  

Do not select any option from the 
Select Specific Annotations drop-
down menu.  
Instead, select only the 
Homozygous or Heterozygous 
checkboxes. You can select one option 
or both, depending on what type of 
variants for which you want to filter. 

45849 In Genexus™ Assay Development Software 6.8.1.1, the 
Analyze as single Barcode parameter value in assay 
templates for use with sequencing runs with Ion 
AmpliSeq™ and Ion AmpliSeq™ HD panels might be 
incorrect for runs on GX5 chips, and might be missing 
for runs on GX 7 chips. 

When you create custom assays for Ion 
AmpliSeq™ and Ion AmpliSeq™ HD 
panels for use with sequencing runs on 
Ion GX5 chips, we recommend that the 
Analyze as single Barcode parameter 
value be updated. See the  
 
Analyze as a single barcode 
parameter setting table for the 
recommended values based on the 
panel type and chemistry.  
 
Go to Assays ► Create Assay, and 
click Next to open the parameter step, 
then verify or change the Analyze as 
single Barcode parameter in the 
Primary Analysis section of the 
screen.  

45943 The coverage graph in the Key Findings screen of 
sample results for a sequencing run that uses the  
Oncomine™ BRCA Assay w4.1.1 shows only a CNV 
call if a SNP is also detected at the same location. 

To see all results, see the Key Variants 
section in the Key Findings tab and the 
data that is in the Variants tab. 

46171 A visualization of sample results for a sequencing run 
that uses the  
Oncomine™ BRCA Assay w4.1.1 shows an SNP and 
CNV call as present at the same location in the data. 
However, only the CNV call is shown in the Coverage 
Graph view of the Key Findings screen. 

To see all results, see the Key Variants 
section in the Key Findings tab and the 
data that is in the Variants tab. 

47790 When you add a new annotation set, enter a name for 
the annotation set, then select VariantDB (Custom) as 
a new annotation source, you are unable to save the 
annotation set. 

The annotation source named 
VariantDB (Custom) is not supported 
in Genexus™ Software 6.8.2. 
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36387 A known issue in Genexus™ Software might yield false 
positive results if a high-density hotspots region is 
overlapped by a de novo deletion. For example, if a de 
novo deletion c.700_712delTACAACTACATGT 
(chr17:7577569-7577581 delACATGTAGTTGTA) in 
TP53 gene is present, and overlaps with 23 hotspot 
SNPs in the region, 2 of these hotspot SNPs 
(COSM44321 chr17:7577569 A>G and COSM45329 
chr17:7577571 G>A) might be called as false positive 
SNPs. 

Examine the evidence of the hotspot 
SNP in a genome browser to confirm 
whether the SNP call is correct. The call 
is correct if both the de novo deletion 
and the hotspot SNP are reported as 
present by the software. If the de novo 
deletion is present but there is no 
evidence of hotspot SNP in the genome 
browser, such a hotspot SNP call is a 
false positive and should be manually 
discarded. 

46305 

When you open a CNV plot for a BRCA sample results 
visualization, the first time you click Pre-corrected to 
toggle to view a pre-corrected plot, both pre- and post-
corrected plots are shown. 

This issue affects only how run results 
are shown in the software and does not 
impact sample results. After the first 
toggle, subsequent toggles between the 
pre- and post-corrected plots during the 
same software session show only a 
single plot as expected. 

42946 If you copy and edit two different versions of the 
Oncomine-Precision-GX5 assay, the CNV calling 
parameter file from the version of the assay that was 
initially edited is incorrectly used for both copies of the 
assay. 

Contact your Field Bioinformatics 
Specialist (FBS) or Clinical Account 
Consultant (CAC) for instructions to 
enable the correct CNV parameters. 
 

39861 
 

When the Bam Uploader option is used to transfer 
BAM files between more than one Genexus™ 
Integrated Sequencer, the software appends the sample 
names to add version and nucleic acid type to the 
names for use on the destination sequencer. If a sample 
name is approximately 50 characters or more, the 
software might delete part of the original sample name. 
As a result, multiple BAM files might be listed under a 
single sample in the BAM files that are transferred.  

To avoid having multiple BAM files 
listed under a single sample in target 
server, do not transfer samples from a 
run that includes samples with names 
greater than 50 characters in length. 
Before you start a run that will be 
transferred to another 
sequencer, ensure that the names of 
samples used in the run plan are not 
greater than 40 characters in length.   

39367 If you have a new installation of the Genexus™ 
Integrated Sequencer and do not yet have any fusion 
references installed, an upload of a fusions panel ZIP 
file (that contains a reference.bed file and a 
reference.fasta file) directly from AmpliSeq.com the 
upload can fail. 

Ensure that you upload a fusions 
reference before you upload the fusions 
panel ZIP file. 
Alternatively, import (from the software 
updates screen) or upload (from the 
Manage Assays screen) an assay 
definition file (ADF) from Thermo 
Fisher Connect that contains a fusion 
reference.  

40236 The name of two gnomAD Annotation genomic 
references are shown incorrectly in the Annotation tab 
of the Results screen. 

• “Alternate allele frequency in samples of Non-
Finnish European ancestry” is shown as 
“GnomAD FNFAF”. The correct name is 
“GnomAD ENFAF”. 

“Alternate allele frequency in samples of male ancestry” 
is shown as “GnomAD MAF”. The correct name is 
“GnomAD MAL”. 

N/A 

42847 When multiple sample PDF reports are downloaded 
from the Sample Results or Run Results screens, 
folders for the downloads are sometimes empty. 

Review and download individual reports 
for each sample in the Sample 
Reports. 

https://ampliseq.com/login/login.action
https://www.thermofisher.com/us/en/home.html
https://www.thermofisher.com/us/en/home.html
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42946 PQ runs with names that exceed 25 characters  are 
shown incorrectly in PDF reports. The run plan name 
overlaps with other fields such as PQ status in the 
reports. 

Field service representatives should 
use PQ run names with fewer than 25 
characters. 

43231 The Required column in the sample attributes table for 
the Sample Type and Collection Date attributes might 
not display values correctly in the Manage Attributes 
screen. The value might be No  when it should be Yes. 
This has no impact on the creation of a sample in the 
software. 

N/A 

43896 In the Annotations tab of the Manage Presets screen, 
the value in the Last Modified On column in a system-
installed annotation set that has been associated with 
an assay change from N/A to a date. The content of the 
system-installed annotation set is not changed when the 
annotation set is associated with an assay. 

N/A 

35975 While planning a run, if you select an Ion Reporter™ 
Software account is used that has a EULA that is not 
accepted, an error is shown. 

You must sign into the Ion Reporter™ 
Software account and accept the EULA. 
Alternatively, select another Ion 
Reporter™ Software account to use in 
the run plan. 

35963 Some content that appears in the software is not 
correctly translated into supported languages. The 
content is shown in English in the software screens.  

N/A 

35269 If a run is edited within the same day that automatic or 
manual backups or cleanups are completed, run data 
might be deleted during the cleanup process. 

Ensure that you wait 24 hours after run 
results are restored or cleaned up in the 
software before runs are edited. 

36910 When you create a sample from a BAM file and select 
Breast Cancer as cancer type sample attribute, the 
system-installed Breast Cancer gene list is applied to 
the run results by default. The Breast Cancer gene list 
does not include BRCA1 or BRCA2 genes. 

Select No Gene List in the Key 
Findings tab to enable the display of 
BRCA1 or BRCA2 in the software. 
 
Alternatively, create a custom gene list 
with cancer type of Breast Cancer that 
includes BRCA1 and BRCA2 for use 
with the BRCA Assay. 

35191 When you export an assay that is created from a 
custom panel ZIP file that is downloaded from 
AmpliSeq.com, and then import the assay to another 
Genexus™ Integrated Sequencer, on which the same 
custom panel ZIP file has been uploaded, a validation 
error for a panel mismatch will occur.  

Create a custom assay on 
the Genexus™ Integrated Sequencer 
on which you want to import the assay 
(that is, the target sequencer), that uses 
the same presets as that of 
source Genexus™ Integrated 
Sequencer. Assay parameters can then 
be exported from the source sequencer 
and imported to the target sequencer. 

https://ampliseq.com/login/login.action
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36378 When you create a report template that includes a 
section for images, the option Browse Image, which is 
used to browse for an image and add it to the template, 
does not work if the template is used to automatically 
generate a report during a run. 

Use the report template to generate a 
variant report after the run is completed. 
In the Generate Report dialog box, 
click Upload Image, then 
select Browse Image and click Select 
File, then select the image or images to 
include in the report. Enter a title for the 
image, and if needed enter a 
description and footnote for the image. 
Continue with the steps to generate the 
variant report, as described in the 
Genexus™ Software help system. 

34986 Responses for an API request for a report-templates 
that include a specific report template ID, include all 
report templates instead of only the report template that 
is associated with the report template ID. 

N/A 

36195 
 

The Non-Human Reference assay type is not currently 
supported for Bam to Result runs that are planned with 
Genexus™ Software. 

N/A 

21701 Software assays that are created in Genexus™ 
Software, or assays that are copied and edited, and 
contain a Sequence Variant Baseline file that was 
exported from Genexus™ Software 6.2 cannot be 
imported into a Genexus™ Integrated Sequencer that 
uses Genexus™ Software 6.6 or later. 

Upon upgrade from Genexus™ 
Software 6.6 to Genexus™ Software 
6.8, you can copy the assay that will be 
exported, or enter at least one edit to 
the assay. When one of these actions is 
done, the assay can then be exported 
and imported to Genexus™ Integrated 
Sequencer that uses Genexus™ 
Software 6.6 or later. 

21491 For SARS assay results, when a sample is uploaded to 
another Genexus™ Integrated Sequencer, the sample 
is defined as DNA BAM Sample instead of RNA (the 
SARS assay is an RNA assay). 

When the import to the target 
sequencer is complete, you can edit the 
sample, map the BAM to the RNA BAM 
file attribute and relaunch the BAM to 
Result run. 

33039 When you create a new report template and select the 
option to add an image, some formats which are not 
supported are shown in the software. 

Select only JPEG, PNG, GIF, or TIFF 
formats in the software. Other image 
formats are not supported. 

34392 
 

When you create a new report template with the “Other” 
application category, the new report template shows the 
application category as “Default” instead of “Other”. 

N/A 

31888 If you copy and edit an Oncomine™ TCR Beta-LR – 
GX5 – w1.3.0 assay and set the chip type to Ion 
Torrent™ GX7™ Chip, the Templating Kits field in the 
software workflow step contains the incorrect selection. 
And, if you select the GX7 templating kit, the software 
might show an error. 

The Oncomine™ TCR Beta-LR – GX5 – 
w1.3.0 assay is not compatible with the 
Ion Torrent™ GX7™ Chip.  
We recommend that you start over on 
the edit of the assay from the Manage 
Assays screen and use only selections 
for the Ion Torrent™ GX5™ Chip. 

34543 Software counts in the Manage Gene Lists screen show 
a count that incorrectly includes obsoleted/inactivated 
gene list records and should not be counted. 

Inactivated gene list records will get 
added to the counts of the Gene Lists 
total items that are available in table, 
but not show up in the Gene Lists table. 
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34226 When a new report template is created for 
an Oncomine™ Comprehensive Plus – DNA Assay or 
an Oncomine™ Comprehensive Plus – DNA and 
Fusions Assay, if the Complex Biomarkers section is 
removed from the Configuration pane, the section 
cannot be added again from the Add Section dropdown 
menu, or with the Bulk Add option. 

This affects reports for Oncomine™ 
Comprehensive Plus – DNA Assay and 
Oncomine™ Comprehensive Plus – 
DNA Assay and Fusions Assay. 
To restore the Complex Biomarkers 
section to the Configuration pane in the 
Report Template, refresh the page and 
select the Oncomine™ Comprehensive 
Plus assay and select starting template 
as Oncomine™ Comprehensive Plus 
from Start From Existing Report 
Template dropdown. 

34359 Previous versions of the CoverageAnalysis and 
MolecularCoverageAnalysis plugins are shown in 
Genexus™ Software 6.8. However, the previous 
versions are not compatible with the latest version of the 
software. 

If you use Genexus™ Software 6.8, 
ensure that you use CoverageAnalysis 
5.18.02 plugin and 
MolecularCoverageAnalysis 5.18.02 
plugin. If you use Genexus™ Software 
6.6, ensure that you 
use CoverageAnalysis 5.16.0.4 and 
MolecularCoverageAnalysis 5.15.0.5 
plugin. 

34494 
 

If you create a custom Germline assay for use with the 
GX5 and GX7 chips, and change the templating size to 
400 bp, the assay shows an incorrect number of flows. 
(550 flows instead of 852 flows). 

After you create the assay, edit the 
sequencing flow to 852, which is the 
default settings for all other templates. 

35417 The option to select an assay of interest to upload the 
sample results (BAM files) and automatically start an 
analysis with the SARS assay on another Genexus™ 
Integrated Sequencer is not available. The option to 
Upload Only is available. 

If you transfer a SARS assay to another 
Genexus™ Integrated Sequencer, 
create a BAM to result planned run to 
analyze the run on the 
second Genexus™ Integrated 
Sequencer. 

29273 A single BAM file that includes all barcodes for a single 
sample is generated in addition to PNG files for 
sequencing runs that use multiple pools. Genexus™ 
Software does not generate individual BAM and PNG 
files for each pool-wise barcode of single sample. As a 
result, these BAM and PNG files are not available to 
download. 

For sequencing runs that use multiple 
pools, download a single BAM file or a 
PNG file that includes all barcodes for a 
single sample. 

34360 When you use the DNA and Fusions application 
category to create or copy and edit an assay for the 
Oncomine™ Plus panel, the option is available. 
However, the MSI is not supported for DNA and Fusions 
samples. 

N/A 

35268 If a run is edited within the same day that automatic or 
manual backups or cleanups are completed, edits that 
affect the run data might be deleted during the cleanup 
process. 

Ensure that you wait 24 hours after run 
results are archived or restored in the 
software before runs are edited. 

30298 When you create an exon tile assay baseline and select 
samples, you must select samples for the appropriate 
panel and for the correct library chemistry. 

Ensure that you use only samples from 
the panel for which the baseline will be 
used. The samples should not be from 
multiple panels or multiple library 
chemistry types. For example, do not 
mix Ion AmpliSeq™ and Ion 
AmpliSeqHD™ samples in the same 
baseline. 
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33953 The template file used to import library batches has a 
column named “Extraction Method Type” for the Nucleic 
Acid Type template item.  

Use the column named “Extraction 
Method Type” to enter information 
about nucleic acid types in the library 
batch template file 

34418 
 

A gene symbol that does not have a valid HGNC ID is 
not displayed under the Annotations tab in sample 
results shown in the Variants tab in the software. 

Export the samples file (TSV or XLS 
format) to view all gene symbols and 
make corrections to the sample entries 
if desired. 

11380 The sorting function of the Locus column on the Run 
Results screen does not work as expected. Although 
you can click on the column heading to sort the data in 
the column, the list is not sorted numerically by 
chromosome number. 

To sort records numerically, sort the list 
of chromosomes. 

35478 
 

If a target regions file includes sample ID (SID) regions, 
and variants are detected in those regions, then those 
variants will be listed as non-hotspot variants in the 
results in the Variants tab of the Key Findings screen. 

You can manually review these variants 
and not include them in reports, if the 
variants belong to SID regions. 

36096 
 

When you upload duplicate files that have the same file 
names for DNA and Fusion panel designs, you will see 
the same error message for both uploads. 

Change the filename to resolve the 
issue and no longer see the error 
message. 

34784 For aneuploidy run results, no filter chain is associated 
when no value for a filter chain is selected in the Run 
Results screen. 

Select “No filter chain” or any other filter 
chain that is shown in the results page, 
then regenerate the report. After a filter 
chain is selected from the dropdown 
menu, the report can be generated 
successfully. 

35940 When you prepare a library batch and use the Include 
NTC option, the NTC sample is not included in the 
library batch that is created if you select the maximum 
number of samples that can be added to an assay. For 
example, if you use the assay Oncomine™ Precision – 
GX5 – Solid Tumor – DNA and Fusions – w3.2.0, the 
maximum allowed samples is16, and the maximum 
allowed libraries is 32. 

N/A 

22891 
 

If you create and save a run plan, then click Edit in the 
Manage Runs screen, then click through the workflow 
steps, but do not make any changes, an Edit entry in 
shown in the Audit screen. The entry has blank values 
for Old Values and New Values. The entry shows that 
an Edit of the run plan occurred, although no edits were 
made to the run plan. 

N/A 

35258 Although 3 characters are required to search the list of 
filter dropdown values in the Sample Results table, the 
entry of 2 characters will generate a list of available filter 
dropdown values that pertain to the current screen only.  

Enter at least 3 characters when using 
your search for filters in the Sample 
Results screens to search across all the 
records. 

35291 There are some system-installed assays that are 
preconfigured to generate RNA Exon Tile Fusion 
Imbalance results during analysis. If you use a custom 
assay that is created by copy-editing such assay, you 
can view RNA Exon Tile Fusion Imbalance results and 
generate a visualization from the software. If you create 
an assay without these predefined settings, you cannot 
view RNA Exon Tile Fusion Imbalance results in the 
software. 

Use a copy of the system-installed 
assay to analyze or reanalyze the run 
results, then view the RNA Exon Tile 
Fusion Imbalance visualization for the 
sample results for the reanalyzed run. 
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36574 BRCA germline analysis workflows are not shown in the 
list of analysis workflows to select for transfers of 
samples (BAM files) from Genexus™ Software to Ion 
Reporter™ Software. 

Sign into Ion Reporter™ Software and 
manually launch the analyses for 
samples that are transferred from 
Genexus™ Software. 

36047 
 

The software does not enforce the use of password 
protected SSH keys, but the use of a password for the 
SSH keys is strongly recommended. Do not share the 
SSH private key or the credentials for the SSH private 
key. The SSH key should be used only by the user who 
creates the SSH key. 

Do not share the SSH private key or the 
credentials for the SSH private key. The 
SSH key should be used only by the 
user who creates the SSH key. 

36678 When you create a new assay, or copy-and-edit an 
assay, the Annotation parameter value “Functional 
Annotations For All Alleles” does not work correctly. 

To create a new assay, or copy-and-
edit an assay in Genexus™ Software 
that includes the Annotation parameter 
value “Functional Annotations For All 
Alleles”, you must use an 
annotation.json file that is manually 
edited. Contact your Field 
Bioinformatics Scientist (FBS) or Field 
Support Engineer (FSE) for assistance 
with the change. 

35679 Manager and administrator-level users can augment an 
existing copy number baseline. The software allows you 
to select an existing baseline for augmentation from the 
dropdown menu, even if the baseline is obsolete. 

Do not use select an obsoleted baseline 
when you augment a copy number 
baseline. 

35976 When Genexus™ Software runs that contain samples 
which include the Collection Date attribute are uploaded 
to Ion Reporter™ Software, the sample Collection Date 
attribute is not shown for the samples in Ion Reporter™ 
Software. 

Edit the sample in Ion Reporter™ 
Software and define the Collection Date 
attribute value. 

33289 

 

Under rare circumstances, the Allele Frequency (AF) of 
a long insertion or deletion (INDEL) is calculated 
incorrectly such that the frequency may be greater than 
100% when the long INDEL is discovered by the long 
indel assembler of the software. 

N/A 

34020 
 

If data for annotation tracks in Variant Pileup view have 
the same start and end base positions, detailed 
information is not shown in the Gene Browser in the 
Variant tab, when you click on the green tiles.  

To view details for the data in the 
annotation tracks, you can open the 
results in the Broad Institute’s 
Integrative Genomics Viewer (IGV).  

35729 When you upgrade to Genexus™ Software 6.8, email 
notification settings that are set in the Backup and 
Restore screen might be reset to the default settings. 

In the Backup & Restore screen, in the 
Email Notifications Settings section, set 
the email notifications to the settings 
that were used prior to the upgrade. 

35705 When you upload samples to another Genexus™ 
Integrated Sequencer and select the option 
to automatically start a run with the selected assay, it 
might fail to launch the assay although the samples are 
successfully uploaded, if the assay that you select in the 
Genexus Workflow column has a trademark in the 
name. 

This affects the system-installed 
aneuploidy assays in the software, 
which have trademarks in the names. 
Plan and use a BAM to Results run on 
the target Genexus™ Integrated 
Sequencer for large number of samples 
that use the assay 
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number  Issue Summary Impact and Mitigation 

37196 
 

In a sequencing run that uses multiple assays, 
reanalysis of multiple run results with the same assay 
might result in an error or incorrect results. 

Reanalyze only run results that use a 
single assay at a time. 

37524 Manager- and administrator-level users can add new 
custom genome reference files in Genexus™ Software, 
which are listed in the References table. Custom 
genome references can be obsoleted with the Actions 
menu in the table. When the obsolete action is used, the 
software shows the message “Reference <Reference 
Genome Name> successfully obsoleted” but the 
software is not updated to reflect the obsolete state. 

An obsoleted custom genome reference 
file will be available to add or import to a 
panel. However, we recommend that 
you do not use reference genomes files 
that are obsoleted in the software. 

37516 The VCF entry for fusions imbalance does not produce 
READ_COUNT entry in a VCF results file. In such 
cases, the Genexus™ Software 6.8 Variant tab shows a 
Read Count of 0. 

The issue also affects comparison of 
results in the software and variant PDF 
reports. 

36284 If a sequencing run is stalled for more than 120 hours, 
go to Settings ► Services and review the list of runs in 
the Active Jobs section. The run will not be listed under 
Active Jobs. 

If the run is still active but the run is not 
listed under the active jobs, reboot the 
Genexus™ Integrated Sequencer. After 
the reboot, the run status will be marked 
as Stalled, and the Reanalyze action 
will show in the list of runs. Reanalyze 
the run so that its analysis can be 
completed. 

36417 The CoverageAnalysis results for the DNA Barcode 
under the Barcode column cannot be opened in the 
Integrated Genomic Viewer (IGV) if you click the option 
to Show or Hide the Panel, then select the Total Reads 
or Strand Reads options from the ‘Reference Coverage 
Chart’. An error is shown when the IGV.jnlp file is 
downloaded and opened. 

The .jnlp file that is downloaded from 
CoverageAnalysis results does not 
launch IGV. However, you can view and 
download the .jnlp file from Variants tab 
for use with IGV. 
 
 
 

35198 If you restore a run that has no backup of one or both of 
these file types: sequencing output files and 
intermediate files, or one of these file types, an incorrect 
audit record is displayed. When the run restoration is 
completed under these circumstances, the audit record 
includes “Sequencing Output & Intermediate Files 
Deleted = false” under New Values. However, this audit 
record is incorrect because the backups are not 
available, and therefore the sequencing output files and 
intermediate files for the given run cannot be restored. 

N/A 

35155 When an administrator user tries to edit the profile for an 
already existing user who has lock-level sign off 
permissions, the lock symbol is not shown next to the 
selected electronic signature type in the User 
management screen. The lock symbol is shown 
correctly when an administrator user creates a new user 
and wants to assign the locked electronic signature from 
the new user configuration page. 

N/A 

32559 
 

Some sample results screens list additional incorrect 
statuses in the Sample Status column when using the 
“Terminated” filter, including Library Preparation 
Aborted, and Resequencing Aborted. The sample 
results screen should instead show statuses only of 
Terminated for such results. 

N/A 
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number  Issue Summary Impact and Mitigation 

34074 A plugin cannot be rerun on a sample result if a plugin 
run is in currently in progress for the sample result.  
 

To avoid the potential loss of plugin 
results data, do not rerun a plugin on a 
sample result when a run for the same 
plugin is in progress. Wait until the 
plugin run is complete before you rerun 
the plugin. 

35785 In some cases, the software will show an error on the 
Sample Results screen if you apply a filter in any 
column of the table and click on the “Started On” 
column. 

The error does not affect the results. 

37197 When uploading sample files in BAM format from one 
Genexus™ Integrated Sequencer to another, if any 
sample name is a partial name of another sample name, 
sample attributes, for the transferred sample on the 
sequencer to which the samples are transferred, are 
likely be incorrect. 

After transferring samples in BAM 
format from one sequencer to another, 
check any sample attribute names in 
which a partial name of another sample 
name is included in any sample name. 
Some sample attributes, such as cancer 
type and tumor cellularity directly impact 
sample results. 
If sample attributes are incorrect after 
sample files are transferred in BAM 
format, edit the sample attributes on the 
sequencer to which you transferred the 
samples. 

37336 Coverage graphs are missing from the Key Findings tab 
for the results of BAM to result runs. Gene coverage 
graphs display correctly in run results but do not display 
correctly after the BAM result file is transferred to 
another Genexus™ Integrated Sequencer.  

You can view coverage information per 
amplicon in the CoverageAnalysis 
plugin results for the run. 

37629 If a new assay is created in Genexus™ Software 6.6 or 
earlier, then copied and edited in Genexus™ Software 
6.8 or later and chip type is changed to GX7, the 
advanced Command Line Arguments parameters are 
not correct in the newly created assay. 

Only the GX5 chip can be used with 
Genexus™ Software 6.6 or earlier. The 
GX7 chip can only be used with 
Genexus™ Software 6.8 or later. 

37625 When you view results in the Variants tab that include 
the variant type RNAExonTiles, if the “Reads” column 
for the genes, NTRK1, NTRK2, or FGFR3 has a value 
of 0, and you click on the variant ID, the Pileup will not 
load any reads. The Pileup view will be blank. 

Close and reopen the results screen to 
view other variants subsequently in the 
Pileup view. 

37455 Information is missing from the info.csv file that is 
downloaded for runs completed on the Genexus™ 
Purification System. 

Review the purification run name and 
instrument serial number are available 
in the Run Summary in the software. 
Alternatively, work with your Field 
Service Engineer (FSE) to get the 
information from a Customer Support 
Archive file. 

37452 To complete sequencing runs with the Ion Torrent™ 
Genexus™ Total RNA Purification Kit for a cell/tissue 
sample type, the Sample to Report run is not supported. 

Plan a Genexus™ Purification 
Instrument only run in standalone 
mode, then transfer samples to a 
Genexus™ Integrated Sequencer to 
perform a sequencing run. 

36863 In rare cases, if the variant is not properly right-align in 
the input VCF file from a given analysis, the cdot 
annotation might be reported incorrectly. 

N/A 
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36333 In rare cases, a reported fusion with good reads count, 
might show zero or very few number of reads with the 
Broad Institute’s Integrated Viewer (IGV), which are 
much less than the number of reads reported in the Ion 
Reporter™ Software Analyses Results screen. This 
could be caused by an additional exon that is amplified 
and sequenced by existing primers, which becomes 
unmapped due to the presence of a large insertion. 
There could also be other technical or biological 
reasons. 

Contact your Field Bioinformatics 
Scientist (FBS) or Field Support 
Engineer (FSE) for assistance. 

36318 
 

When the Genexus Security Package v1.0.0 is installed, 
at the end of the Software Update installation process, 
on the Server Update screen, the “Go To Application” 
button does not get enabled even if the upgrade has 
completed.  

The workaround is to ensure that the 
logs show the message: “Software 
Update completed successfully”. When 
you see this message, refresh the 
screen, and return to the Update 
screen, where the “Go To Application” 
button has become active. 

35505 The option to run a plugin is not shown immediately 
after a signed-off report is deleted from the Reports 
screen.  

Refresh the Reports screen to see the 
option to run a plugin. 

34802 The Ploidy Plot is missing from the PDF report for runs 
that use the ReproSeq™ PGS – GX5 Assay kit. 
Run when the run results are Aneuploidy Positive or 
Aneuploidy Negative. 

N/A 

34414 
 

Sometimes when the run planning page is printed, some 
information is truncated in the printout. 

Adjust the page set up and layout prior 
to printing the run planning page. 

34373 If a variant is an INDEL located on UTR regions, you will 
see the cdot annotation includes position and sequence 
change information, but the information is not in an 
HGVS-compliant format. 

This issue affects results shown in both 
Genexus™ Software and Ion 
Reporter™ Software. 

33902 For some Genexus™ Software assays, a PDF report 
that uses a custom template and includes additional 
columns that were not in the original assay, might show 
no values the value in the additional columns in the 
report. 

Contact your Field Bioinformatics 
Scientist (FBS) or Field Support 
Engineer (FSE) for assistance. 

25297 If you create a custom sample attribute that has no 
space between the words that is named the same as a 
mandatory sample attribute that does include a space 
between the words on the same on one Genexus™ 
Integrated Sequencer, then transfer the samples 
through the IonReporterUploader plugin, the Plugins tab 
will show sample transfer is completed and valid. 
However, the uploaded samples are not listed in the 
target Genexus™ Integrated Sequencer. 

Create sample attribute with underscore 
to separate the words or use different 
letter character case or words. 

36793 
 

Custom assays can be created from system-installed 
templates, and you can copy a locked assay to create 
an assay, or copy and edit user-defined assays. Each of 
these software processes must be done individually, 
that is, you cannot create, copy or edit multiple assays 
in Genexus™ Software simultaneously. Opening more 
than one tab and trying to create, copy or edit assays in 
the multiple open tabs will result in errors and loss of 
entered data. 

Do not open multiple tabs in Genexus™ 
Software for procedures that involve 
data entry. 
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35786 A Sample Status of "BaseCallingActor: Running" is 
sometimes shown for in sample results for runs that use 
the Oncomine™ Comprehensive v3 Assay and are 
terminated. 

N/A 

28966 
 

If you create an assay in the software with the Non-
Human Reference assay type, the Annotation tab is 
shown in the Parameters step of the Create 
Assay workflow bar. This tab should not be visible. 

The Annotation tab has no effect on the 
creation of an assay for the Non-Human 
Reference assay type. 

35391 
 

When you compare sample results in Genexus™ 
Software, you are able to select samples with a 
sample result Status of Obsolete to be included in the 
comparison and include the comparison in a report for 
multiple samples. 

The use of obsoleted samples for 
sample comparisons is not 
recommended. 

37535 The software allows you to create a report template that 
has the same name as a report template that is 
obsolete. 

The use of report templates names that 
are used for an obsolete report template 
is not recommended. 

21541 
 

If you import a custom exon tile assay baseline file in an 
unsupported file format, you are not notified that the 
import failed. The unsupported file appears in the exon 
tile assay baselines list after import. However, analysis 
fails if the custom assay baseline is used in a run plan. 

This issue occurs only if you attempt to 
import a custom exon tile assay 
baseline file in an unsupported file 
format.  
Ensure that custom exon tile assay 
baselines that you import are in a 
supported file format. 

20696 
 

In any column header, when you click Filter, enter any 
information in the search field, then click Enter, all 
options that are listed in the filter dialog box are 
selected. 

This issue applies to all searches in the 
filter dialog boxes in all screens. 
In the filter dialog boxes, do not click 
Enter except to select all options. 

12692 Missing variant label and legend chart customization 
options for charts generated when you compare 
samples. 

This is a chart customization issue that 
does not affect sequencing results.  
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22895 In the Key Findings tab, in the Key Variants matrix, 
variants with more than one gene annotation can be 
listed as Not Assayed even if one of the annotated 
genes is present in the panel. Affected variants are 
shown in the Key Variants matrix only when the Not 
Assayed checkbox is selected and appear at the end of 
the matrix in a white tile instead of a blue tile.  
 
Example: 

 

This issue can affect variants with more 
than one gene annotation: for example, 
U2AF1L5/U2AF1. 
Identify if a variant is affected by this 
issue. 
1. For any gene tile that is shown only 

when the Not Assayed checkbox is 
selected, click the Variant ID to 
open the Variants tab. 

2. Scroll up to view the variant in the 
Variants table. 

3. In the Variants table, in the Gene 
column, if the variant is listed with ** 
to indicate that more than one gene 
is detected, click the Annotations 
tab.  

4. Scroll to the Gene row to view the 
multiple annotations for the gene. 

When you view the Key Variants matrix, 
ensure that you select the Not Assayed 
checkbox, if available, to review 
variants that are not assayed.  

17425 
 

In rare instances, the order of the reads shown in the 
BAM track is not consistent each time you view the BAM 
track in the Gene Browser. 
 
 

 

 
 

This issue occurs only when the total 
read count exceeds the maximum read 
count threshold that is set for optimal 
browser performance. When the 
threshold is exceeded, the Gene 
Browser shows a specified number of 
randomly sampled alignments 
configured by down sampling 
parameters. The coverage track is not 
affected by this issue. 
You can adjust the down sample reads 
parameter and view the full BAM track 
with the Broad Institute Integrative 
Genomics Viewer (IGV). For more 
information, see “View variants with 
IGV” in the software help system. 

23068 If you create a custom panel for the Oncomine™ BRCA 
Assay GX, exon numbering remains set by the system-
installed panel for the assay. As a result, when you use 
a custom panel that is based on a reference sequence 
version that is different from the system-installed panel, 
exon numbering for BRCA1 is not correct when you 
visualize exon and whole gene CNVs.  

This rare issue affects the visualization 
of BRCA1 for the Oncomine™ BRCA 
Assay GX if you use a custom panel 
with a version of the reference 
sequence that is different from the 
system-installed panel for the assay. 
The system-installed version of the 
reference sequence is NM_007294.4. 
 

21320 
 

If the name of a variant report template includes a 
special character of @, *, #, or $, you cannot view or 
download variant reports generated with the template. 

This issue affects any variant report 
with @, *, #, or $ in the name of the 
variant report template. 
Create a new variant report template 
without @, *, #, or $ in the name, then 
generate a new report. 
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23081 When you try to prepare a library batch with more than 
24 samples, an error message is shown for some DNA 
and RNA assays. 

This issue affects some system 
installed and custom DNA and RNA 
assays when you select more than 24 
samples during library batch 
preparation.  
Create an XLS or XLSX file that 
contains the library batch information 
from a template file provided in the 
Import Library Batch screen, then 
import the library batch file. 

20738 Downloading multiple Customer Support Archive (CSA) 
files simultaneously fails. 

This issue occurs when you try to 
download a CSA file while another CSA 
file is downloading. This issue occurs in 
the Run Results, Sample Results, and 
Verification Results screens. 
You must wait for a CSA file to 
download successfully before you can 
download another CSA file. 

16765 
 

Results generated by the coverageAnalysis plugin for 
RNA samples with an application category of oncology 
are not informative.  

This issue occurs only when you view 
the coverageAnalysis plugin results in 
the Plugins tab for an oncology RNA 
sample. 
For oncology RNA samples, you can 
ignore the coverageAnalysis plugin 
results shown in the Plugins tab. 

16763 If you import run results 
from another Genexus™ Integrated Sequencer that has 
a different version of a plugin used in the run, you 
cannot see the plugin results in the Plugins tab when 
you view the results on the target server. 

This issue affects results that are 
imported in a Genexus™ Software 
server that has a different version than 
the source Genexus™ Integrated 
Sequencer. 
Run the plugins again in the target 
server (from a sample result, click the 
More Options ►Run Plugin). 

21807 When you create some custom assays or copy and edit 
some assays, you can enable, edit, and view 
Microsatellite Instability (MSI) parameters in the 
Parameters step of assay creation even though the MSI 
parameters are not applied in the analysis. 

This issue affects some custom assays. 
Ignore MSI parameter settings in 
custom assays when results do not 
show MSI metrics. 

23074 The Oncomine™ Extended (5.14) filter chain launched 
in Genexus™ Software 6.2.1 was updated in 
Genexus™ Software 6.6. The improvements, which are 
part of Oncomine™ Extended (5.16) filter chain, are 
also included in the Oncomine™ Extended (5.14) filter 
chain in Genexus™ Software 6.6. This update can 
result in rare differences to Filtered Variants in 
Genexus™ Software 6.6 when compared to results 
viewed with the Oncomine™ Extended (5.14) filter chain 
in Genexus™ Software 6.2.1.  

This rare issue affects results that are 
viewed when the Oncomine™ Extended 
(5.14) filter chain is applied and 
compared to results in Genexus™ 
Software 6.2.1. This rare issue could 
affect the following Filtered Variants. 
Likely somatic de novo splice variants 
that are not hotspot splice variants or 
ClinVar pathogenic variants are filtered 
in. (Hotspot splice site variants and 
ClinVar pathogenic variants are not 
affected by this issue.) 
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20875 
 

For samples with a disease category of cancer that 
were created in Genexus™ Software 6.2, you cannot 
plan a run or generate a report unless you first edit the 
application category of the samples.  

This issue affects samples created in 
Genexus™ Software. Disease category 
was a sample attribute in version 6.2, 
but in version 6.6, the correlated 
attribute is application category. 
(Cancer is not an available option in 
version 6.6.) 
For samples with a disease category of 
cancer created in Genexus™ Software 
6.2, edit the application category before 
you plan a run or generate a report with 
the samples in Genexus™ Software 
6.6. Alternatively, you can copy 
samples that you created in version 6.2, 
edit the application category for version 
6.6, then plan a run with the new 
samples. 

21487 BAM to Result runs are not compatible with assays that 
are created or installed in previous versions of the 
software. 

This issue affects all system-installed or 
custom assays from Genexus™ 
Software 6.2.1 or earlier.  

 
  



 

Genexus™ Software 6.8 Release Notes 28 

Analyze as a single barcode parameter setting 
Assay template name Library chemistry GX 5 Chip 
DNA Germline AmpliSeq TRUE 
DNA Somatic AmpliSeq TRUE 
DNA Somatic AmpliSeq HD FALSE 
Fusions AmpliSeq FALSE 
Fusions AmpliSeq HD FALSE 

DNA and Fusions AmpliSeq TRUE – DNA extraction type 
FALSE – RNA extraction type 

DNA and Fusions AmpliSeq HD FALSE – DNA extraction type  
FALSE – RNA extraction type 

Generic Sequencing 
Application 

AmpliSeq TRUE – DNA extraction type 

Generic Sequencing 
Application 

AmpliSeq FALSE – RNA extraction type 

Generic Sequencing 
Application 

AmpliSeq TRUE – DNA extraction type 
FALSE – RNA extraction type 

Generic Sequencing 
Application 

AmpliSeq HD FALSE – DNA extraction type 

Generic Sequencing 
Application 

AmpliSeq HD FALSE – RNA extraction type 

Generic Sequencing 
Application 

AmpliSeq HD FALSE – DNA extraction type  
FALSE – RNA extraction type 

Generic Sequencing 
Application 

AmpliSeq HD FALSE – TNA extraction type 

Non-Human Reference DNA - AmpliSeq TRUE 
Non-Human Reference RNA - AmpliSeq TRUE 
Non-Human Reference AmpliSeq HD FALSE 
Non-Human Reference AmpliSeq HD FALSE 
TNA AmpliSeq HD FALSE 
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System Requirements  
Genexus™ Software 6.8 has a browser-based interface that can be viewed using Google™ Chrome™ 
version 90 and above (version 90 has been tested) and is best viewed with a  
1440 x 900 screen resolution. The software is accessed on an independent client computer with a private 
web server. 
Version information 

Release Date April, 2025 

Release Version 6.8.4 

Software plugin versions 
Plugin Version 

customersupportarchive 0.6.5 

coverageanalysis 5.18.0.2 

IonReporterUploader plugin 6.8.0 

molecularcoverageanalysis 5.18.0.2 

sampleid 5.18.0.2 
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